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1. Introduction

1.1 Software Licence Agreement

Important. Please read carefully.

This MobileIT End-User Licence Agreement (hereafter known as "EULA") is a legal agreement between you (the
"User") and MobileIT Solutions Data Pty Ltd ("MobileIT"), for DeskTop.SMS software including computer software,
associated media, licence key or file, printed materials and "on-line" or electronic documentation ("Software").

The terms of this EULA incorporate the entire MobileIT DeskTop.SMS Software product, including individual
variations, configurations and options installed as part of the original installation or within subsequent add-ons,
enhancements or upgrades. Installing, copying, or otherwise using the Software indicates your acceptance of this
agreement, and indicates your decision to be bound by the terms of this licence. After reading this EULA carefully,
if you do not agree to all of its terms, you must not install, use or transfer the Software.

LICENCE: Pursuant to this EULA, you acquire the right to use the Software strictly in accordance with the
provisions of this agreement and make one copy only for backup, archival or security purposes. The Software may
only be used pursuant to this EULA by the User. You must not copy, alter, modify, reproduce or reverse-engineer
the Software except to the extent otherwise authorized by this licence.

COPYING: You must ensure any copy of the Software made pursuant to this EULAError! Bookmark not defined.
bears notice of the MobileIT ownership of copyright and a notice stipulating that the Software contains
information confidential to MobileIT.

MODIFICATIONS: You must not modify or alter the Software or merge all or any part of the Software with any
other software without written permission from MobileIT. Software as modified or altered remains the property
of MobileIT in all respects, whether modified by you, MobileIT or a third party and whether or not authorized
pursuant to this EULA. Specifically, you must assign MobileIT all intellectual property rights arising out of any
modifications to the Software. This EULA will apply to the Software as modified or altered.

COPYRIGHT/PROPRIETARY PROTECTION: The Software is owned by MobileIT and is protected by international
copyright laws and treaties, as well as other intellectual property laws and treaties. You must treat the Software
like any other copyrighted material. Any violation of this licence will automatically terminate your right to use the
Software and you must immediately return all copies of the software and associated materials to MobileIT.

LICENCE PROHIBITIONS: The Software is licenced, not sold. You acknowledge that you are not obtaining title to
the Software, any modifications, updates or any copyrights. You may not sub-licence, rent, lease, convey, modify,
translate, convert to another programming language, disassemble, de-compile, reverse-engineer or attempt to
discover the source code of the Software for any purpose. You may not copy, duplicate, publish or otherwise
disseminate any documentation and printed materials supplied with the Software.

SOFTWARE TRANSFER PROVISIONS: Where this licence has initially been granted to a MobileIT Value Added
Reseller (VAR), MobileIT hereby grants the VAR, the right to transfer this licence to you (the end-user customer).

VAR APPOINTED AS AGENT: Where this licence has not initially been granted to a VAR and MobileIT is not
contracting directly with you, despite clause 3.1 of the MobileIT Reseller Distribution Agreement, MobileIT
appoints the VAR as its agent solely for the purpose of entering into this licence with you on MobileIT’s behalf.

DISTRIBUTION: If this Software is used by a VAR or its agents, employees or contractors for the purpose of
supporting or marketing MobileIT equipment or software, the VAR or its agents, employees or contractors is
deemed to be the end-user and the VAR is therefore bound by the terms of this EULA to ensure that its agents,
employees or contractor comply with the terms of this licence.

USE OF THE SOFTWARE: You may use one copy of the Software on one server or client computer. If this is a
multi-computer or network licence, you may install and use additional copies of the software on client workstations
up to the number of copies authorized by MobileIT.

A copy of the Software is considered to be in use when loaded into temporary memory (e.g. RAM) and/or installed
on a permanent storage device (e.g. HDD, CD-ROM etc.)
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TERMINATION: Without prejudice to any other rights, MobileIT may terminate this agreement if you fail to comply
with the terms of this EULA or the MobileIT Reseller Distribution Agreement is terminated (if the end-user of this
Software is a MobileIT VAR). In such event, you must destroy or return to MobileIT all copies of the Software
and all of its associated component parts.

If MobileIT terminates this licence, in addition to terminating the licence, MobileIT may:

(a) repossess any copies of the Software in your possession, custody or control;
(b) retain any money paid;
(c) charge a reasonable sum for work performed in respect of which work no sum has been previously charged;
(d) be regarded as discharged from any further obligations under this licence; and
(e) pursue any additional or alternative remedies provided by law.

LIMITED WARRANTY: MobileIT warrants any physical media to be free from defects in materials and workmanship
for a period of ninety (90) days from date of sale. Subject to the terms of the MobileIT Reseller Distribution
Agreement and to the extent permitted by law, any condition or warranty, which would otherwise be implied in this
EULA, is excluded. Where legislation implies into this licence any condition or warranty which is not capable of
exclusion or moderation, which condition or warranty will be deemed included in this licence. However, MobileIT’s
liability for breach of any such condition or warranty will be limited, at MobileIT’s option, to one or more of the
following:

(a) if the breach relates to goods
    (i) the replacement of the goods or the supply of equivalent goods;
    (ii) the repair of such goods;
    (iii) the payment of the cost of replacing the goods or of acquiring equivalent goods; or
    (iv) payment of the cost of having the goods repaired; and
(b) if the breach relates to services
    (i) the supplying of the services again; or
    (ii) the payment of the cost of having the services supplied again.

Any written or oral information or advice given by MobileIT employees or VARs will in no way increase or change
the scope of this warranty.

LIMITATION ON CONSEQUENTIAL DAMAGES: Neither MobileIT nor anyone involved in the creation, production, or
delivery of the Software shall be liable for any indirect, consequential, or incidental damages arising out of the use
or inability to use the Software even if MobileIT has been advised of the possibility of such damages or claims. In
no event will MobileIT’s liability for any damages exceed the price paid for the licence to use the software,
regardless of the form of claim. Users of this Software agree to indemnify, hold harmless, and defend MobileIT
from and against any claims or lawsuits, including legal fees that arise from the use or related to the use of the
Software.

JURISTICTION: This EULA is governed by the laws of the State of New South Wales, Australia. The United Nations
Convention for the International Sale of Goods shall not apply. This EULA is the entire agreement between us and
supersedes any other communications or advertising with respect to the Software product; this EULA may be
modified only by written agreement signed by authorized representatives of you and MobileIT.

Please contact MobileIT should you have any questions regarding this EULA:

Address: MobileIT Solutions Data Pty Ltd
Level 2, 55 Blaxland Road
Ryde
New South Wales 2112
Australia

Phone:  +61 (0)2 8878 3223
Fax:  +61 (0)2 9809 0555

Web:  www.mobileit.com.au
E-Mail:  info@mobileit.com.au

http://www.mobileit.com.au
mailto:info@mobileit.com.au
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1.2 Product Overview

In today’s world, communicating fast and cost-effectively is essential. Good communication
can be the difference between winning a contract or losing a valued client. To address the
need for fast and efficient communications, MobileIT have developed DeskTop.SMS, the
ultimate PC to mobile phone text messaging solution.

With DeskTop.SMS, text messages can be sent from your PC through a GSM modem to
either an individual, a number or individuals or a specific group. The message recipient can
even send a text reply back to your PC.

Key features of DeskTop.SMS include:

 Send text messages from your PC to any GSM/CDMA mobile phone
 Send a text message to an individual, selected individuals or broadcast a

message to a group
 Receive text messages to your PC
 Import contact details from Microsoft Outlook directly into the DeskTop.SMS

Phone Book
 Schedule messages for dispatch at a later time
 Regularly used messages can be stored and retrieved using the QuickSMS

feature
 Logs kept of all messages sent and received
 Export sent and received messages to Microsoft Excel
 Diagnostic mode to aid fault finding
 Includes TWIST dual-band GSM modem

An example application of DeskTop.SMS is as follows:

The Sales Director wants to co-ordinate an urgent sales meeting for the day after tomorrow
and all twenty sales executives must attend. Just imagine how long it would take to call
each individual sales executive, and at what cost?

With DeskTop.SMS the Sales Director would simply type:

"Attn: Sales Team. URGENT sales meeting at 9 AM,
9 MAY, SYD. office. Attendance mandatory, please
confirm by return. Rgds Mel".

The Sales Director then selects "Sales Team" from the
Phone Book and presses Send.

This broadcast text message will be sent to all individuals
in the sales group and be delivered within seconds. Not
only that, sales people can then send a text message
back confirming their attendance.
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2. Installation
To start using DeskTop.SMS you must install the TWIST dual-band GSM modem and your
copy of DeskTop.SMS onto the PC.

The following section is designed to guide you through the installation process.

2.1 Pack Contents

Before you begin, please verify all contents of the DeskTop.SMS sales package are present
as follows:

 CD-ROM containing a copy of the DeskTop.SMS software and user manual
 Document containing your personal DeskTop.SMS registration key number
 TWIST dual-band GSM modem (note that the GSM modem does not contain a

SIM card; please contact your mobile phone network supplier if you do not
have a SIM card available for use)

 Serial communications cable (9-pin RS232 male to female variety)
 Power supply, aerial and wall mounting bracket for TWIST GSM modem

If you are missing any of the above items, please contact MobileIT for assistance.

2.2 Minimum System Requirements

To successfully install DeskTop.SMS your PC must conform to the following minimum
system requirements:

 Intel Pentium® (or equivalent) CPU running at 233MHz (or faster)
 16Mb RAM (or greater)
 20Mb minimum free hard disk drive space
 CD-ROM drive (4x minimum) for installation purposes
 One free 9-pin RS232 serial communications port (e.g. COM1)
 Supported 32-bit operating system (i.e. Microsoft Windows 95, 98, Me, NT,

2000 and XP)
 VGA monitor (or better), 800x600 resolution, 256 colours (or greater)
 Microsoft Windows-compatible keyboard and mouse

Once you have confirmed the minimum system requirements, please proceed to the
installation of the TWIST GSM modem.
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2.3 Installing the TWIST GSM Modem

The TWIST GSM modem enables connections to be made to the GSM 900/1800 (1900)
mobile radio network via your PC.

DeskTop.SMS uses the TWIST GSM modem to send and receive SMS text messages.

The TWIST GSM modem must be installed before the DeskTop.SMS software.

To install the TWIST GSM modem, please follow this procedure:

 Remove the TWIST GSM modem components
from the DeskTop.SMS sales package and
orientate yourself with the modems major
features.

 Open the cover cap on the underside of the
modem.

 Turn the securing plate as far as it will go with the aid of
the removed cover cap.

 Flap the holder upwards. Take your SIM card and slide it
into place. Make sure that the gold-plated contact surface
is facing downwards towards the contacts. Press the
holder down and secure it with the cover cap.

 Replace the cover cap. The insertion is now complete. If
you wish to remove the SIM card at any point, simply
follow the reverse process.

Important. The SIM card must be inserted before connecting the modem to the
power supply and must not be removed until the power has been switched off.
Insertion or removal of the SIM card with the modem power supply on may cause
irreparable damage.

Important. Please ensure that the SIM card does not require a PIN code to be
entered for it to connect to the network. If you are unsure, temporarily install the
SIM card into any GSM phone and switch on. If the phone requires a PIN code,
please refer to the phone manual to disable the PIN code requirement.
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 Push the GSM aerial into the aerial socket (SMB) on the modem and make sure that
it locks comfortably into place.

If the supplied GSM aerial is not suitable for your requirements, the TWIST GSM
modem will accept any separate GSM aerial (providing that it has an SMB
connector) into the aerial socket. In most cases, the supplied aerial should suffice.

 Take the female end of the 9-pin RS232 serial cable and connect it to a free 9-pin
serial port on your PC (e.g. COM1, COM2 etc.).

 Take the opposite male end
of the serial cable and
connect it to the serial port
on the modem.

 Tighten the serial cable connection screws hand-tight.

 Attach the end of the power cable into the power
supply socket on the modem and make sure that it
locks comfortably into place.

 Plug the power supply into an AC/DC wall socket.

 The orange LED indicates power supply status. If the
LED is on, the device has power. If the LED is off, the
device has no power and you must check the supply.

 The green LED indicates data traffic throughput or modem activity. It will flash when
active.

You can verify that the TWIST GSM modem has been correctly installed by using a
third-party communications program (such as HyperTerminal on Microsoft

Windows) to talk to the modem via the allocated COM port. If the modem has
been installed correctly, you will be able to issue AT commands.

 Installation of the TWIST GSM modem is now complete. Please proceed to the next
section.
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2.4 Installing the DeskTop.SMS Software

The DeskTop.SMS software uses the TWIST GSM modem to send and receive text messages
across a mobile phone network. Please verify that you have installed the TWIST GSM
modem before you continue.

To install the DeskTop.SMS application, please follow this procedure:

 Turn your PC on. Ensure all running applications have been closed (this prevents
shared-file access violations).

 Remove the DeskTop.SMS CD-ROM from the sales package and insert into the
CD-ROM drive of your PC. DeskTop.SMS is an "AutoPlay" program and will
automatically load the installation program when you close the CD-ROM drive door.

 If the PC fails to automatically load the
installation program from the CD-ROM (i.e. if
the Auto-Insert Notification has been disabled),
you must run it manually. To do this click on the
Start button and select Run. Enter the following
command line to initiate the installation program
D:\SETUP_DESKTOPSMS.EXE (where D is the
letter of your CD-ROM drive) and click on OK.

 Please wait whilst the system loads the
installation program. The first setup
window will now appear. Click on Next to
continue with the installation process.

 The second setup window displays the
MobileIT EULA as found in section 1.1.
Click on Yes to agree to the EULA and
continue the installation process.

If you do NOT agree to these
conditions, you CANNOT install the
DeskTop.SMS software and must click
on No to exit the installation program.
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 The third setup window asks the location
to which DeskTop.SMS will be installed
on your hard disk drive. The default
location is set to C:\Program
Files\DeskTop_SMS (where C is the letter
of your hard disk drive). If the default
location is suitable, click on Next to
continue.

 If you wish to change the default directory to
install DeskTop.SMS at a different location,
please either click on the Browse button and
select a new destination directory or
alternatively type the location of the directory
in the Path field. Click on OK to continue.

Important. The selected directory must be
on a hard disk drive on the PC that has the
TWIST GSM modem installed. If you wish to
use a networked SMS solution, please
contact MobileIT and ask about
WorkGroup.SMS.

 The program now has enough
information to begin installing the
DeskTop.SMS application. If you wish to
change any settings before files are
copied, use the Back button to return to
previous windows. If you are satisfied
with the installation settings, please click
on Next to start copying files to your
hard disk drive.
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 The installation program will now copy files required
by DeskTop.SMS to the selected directory. When the
progress bar is full, file copying has been completed.

 The installation program will
create the DeskTop.SMS Start
menu and Desktop icons.

Look for the DeskTop.SMS
icons in the Programs group
on the Start menu.

 The installation program will now present
the Finished window to indicate that it
has finished installing DeskTop.SMS.
Click on Close to exit from the program.

 Installation of DeskTop.SMS is now
complete.
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2.5 Running DeskTop.SMS for the First Time

The first time you run DeskTop.SMS, you will be asked to set the parameters of your TWIST
GSM modem. This section will guide you through setting the modem parameters.

To run the DeskTop.SMS application, please follow this procedure:

 You can initialise DeskTop.SMS by either clicking on its
Start menu icon or by clicking on its Desktop icon.
Please note that the DeskTop.SMS icon in the Start
menu will be found in the Programs group.

 DeskTop.SMS will now display the Modem
Parameters window. You must select the COM
port on which the TWIST GSM modem is
attached and the baud rate of the connection.

The default COM port value is set to COM1 and may be changed
to any serial port number between COM1 and COM10. Under
most circumstances however, the likely serial port to which the
TWIST GSM modem is attached will be either COM1 or COM2.

The default baud rate value is set to 9600 and may be changed
to either 2400, 4800, 9600 or 19200. Please note that unless you
intend to install a different GSM modem than the TWIST, you will
not need to change this value.

 Once you have verified that the modem parameters are correct,
click on the Exit button to save.

The COM port and baud rate settings will be saved to your hard disk drive. You
will not see the Modem Parameters window again. If you need to modify the
settings you have saved, you must use the Administration window within the
DeskTop.SMS application. For further information on re-setting the modem
parameters, please refer to section 9.
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 DeskTop.SMS will now continue loading.

When first installed, DeskTop.SMS will be in Evaluation mode. Please refer to the
following section regarding the limitations of the un-licenced Evaluation mode and
how to register your product.

2.6 Evaluation Mode and Registering DeskTop.SMS

When the DeskTop.SMS software is first installed, it is set to Evaluation
mode. This un-licenced mode of DeskTop.SMS is designed to allow you to
evaluate the features of the program.

When in the Evaluation mode, the Registration
window (with the MobileIT logo) appears every
time you open the application.

This window serves to remind you that you
have an un-licenced copy of DeskTop.SMS and
allows you to register your product.

Important. The Evaluation mode of DeskTop.SMS has limited functionality.
Without registering the application, you can only send or receive up to 10 text
messages and will NOT be able to delete any messages from the Sent Messages
and Received Messages lists. All other functions are available.

If you wish to continue evaluating the DeskTop.SMS application
without registering, please click on the Close button
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To register your copy of DeskTop.SMS, please follow this procedure:

 If you wish to register your copy of DeskTop.SMS and have a valid
registration code (found in the DeskTop.SMS sales package), do so
as follows: click on the Register button of the Evaluation Mode
window or alternatively, click on the Register your
copy option of the DeskTop.SMS Help menu.

If you do not have a valid registration code (e.g. if you have a downloaded
evaluation copy), please contact MobileIT for assistance on (02) 8878 3236.
Alternatively, click on the Print Registration Form button and fax or e-mail your
registration request to MobileIT.

 The DeskTop.SMS application is licenced
by entering a valid registration code
(activation key) on the Registration form
window. Please enter the name of the
vendor (i.e. from where you bought
DeskTop.SMS), the name, address and
phone number of your company and
registration code (activation key) into the
fields provided.

Important. Please enter your
registration code (activation key)
precisely as found on your registration
document.

Important. The registration code is linked to the serial/IMEI number of the
attached GSM modem. DeskTop.SMS must be able to access the modem to
validate your registration code. Please note that if you change your GSM device at
any point, you will require a new registration code and must contact MobileIT for a
re-issue. You may install copies of DeskTop.SMS on multiple computers but they
will only fully operate when connected to the specific GSM modem for which the
registration code has been issued. If you wish to operate multiple copies of
DeskTop.SMS through multiple GSM devices, please contact MobileIT for
supplementary registration codes.
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 Once you have entered all of the required information, please
click on the Validate Key button to verify your registration code.
If your registration code is valid, DeskTop.SMS will report
Validation successful  and will display the licence information in
the About box on the main window.

 If however your registration code was not validated,
DeskTop.SMS will report that you have entered an Invalid
Activation key. You will need a valid registration code in order to
register your copy of DeskTop.SMS.

When your copy of DeskTop.SMS has been successfully registered, all limitations
will be deactivated and you will be able to send unlimited text messages and be
able to delete messages from the Sent Messages and Received Messages lists.
Thank you for registering your copy of DeskTop.SMS.

 We suggest that you keep a copy
of your registration details by
clicking on the Print Registration
form button. On the following
window, please ensure all
information is present and correct
and click on the Print button. To
close the print preview, click on
the Exit button.

 Once you have registered your DeskTop.SMS application (or decided to continue un-
registered for evaluation purposes), you will need to become familiar with the main
window. The following section describes how to use DeskTop.SMS to send, receive
and organise text messages.
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3. Sending Text Messages
The main window of DeskTop.SMS is the base from which you will be able to compose,
send, receive and organise SMS text messages. This section will describe how you can
compose and send a text message.

Signal strength shows what is the reception of your modem. If modem is disconnected or
the signal strength is weak the indicator will display ‘No signal’.



In s ta l l at ion  and  User  Manual 19/75

3.1 New Message Controls

You will notice that DeskTop.SMS has three tab sections on the main window. These tab
sections are known as the New Message tab, the Messages Received tab and the Messages
Sent tab, and are used to send and organise text messages.

When you wish to send a text message, you must make sure the New Message tab is to the
front.

The controls on the New Message tab are illustrated as follows:
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3.2 Sending a New Text Message

To send a new text message using DeskTop.SMS, please follow this procedure:

 Have the DeskTop.SMS main window open
displaying the New Message tab.

 Type your text message using
the Composure box. Please
note that SMS text messages
allow a maximum of 160
characters per message and
do not allow "Enter"/carriage-returns. DeskTop.SMS displays the number of
characters you have typed above the Composure box.

You can use the Cut, Copy and Paste commands in the
Composure box and in the GSM No. field.

Try using acknowledged abbreviations to shorten your text message (e.g. ATT =
attention, ASAP = as soon as possible, MGMT = management, MSG = message,
RGDS = regards, TEL = telephone, THX = thanks etc…).

 With DeskTop.SMS, you can store pre-typed text messages for convenience. These
can be accessed from the Select quick type SMS box. Select the pre-typed text
message you want and DeskTop.SMS will fill the Composure box for you. For more
information on creating pre-typed Quick SMS text messages, refer to section 7.2.

 Once you have a text message that is ready to
send, you must now select the recipients of the
text message. You may send the message to an
individual, a pre-defined group or a mixture of
individual/group entries. For information
regarding the creation and use of Phone Book
entries, please refer to section 6.

 To type the recipient number, click on the GSM No.
field and enter the number of the mobile phone to
whom you wish to send your text message.

Important. Please ensure that the GSM number entered is in the standard
international format (e.g. +61404818783 instead of 0404818783). Generally,
most numbers require a country code and the omission of the leading 0 digit.
Please refer to section 12.1 for international dialling code numbers.
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 Now you may send the text message by clicking on the Send
button. This instructs DeskTop.SMS to initialise the GSM modem
and send your text message over the mobile phone network.

 Whilst the TWIST GSM modem is being initialised,
ready to send your text message, DeskTop.SMS will
display a Please wait. Looking for modem
notification.

 Once the modem has been initiated, DeskTop.SMS will send your text message over
the mobile phone network to the recipient GSM/CDMA mobile phone. Once the text
message has arrived at the recipient phone, DeskTop.SMS
will request a verification of delivery. During this period,
DeskTop.SMS will display the Waiting for message receipt
notification.

 Once DeskTop.SMS has received the delivery
verification, it will confirm text message delivery with
the 1 SMS message(s) sent successfully. notification.

 DeskTop.SMS will now create an entry in the Messages Sent tab to record the text
message you have just sent. Please refer to section 3.2 for more information on the
Messages Sent database.

 You have now sent a new text message!

DeskTop.SMS will record the number of text messages sent
throughout the day and display the amount beneath the
Send button. As each new day rolls over, DeskTop.SMS will
reset this counter.
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3.3 Viewing the List of Sent Text Messages

To view the list of sent text messages, please follow this procedure:

 Have the DeskTop.SMS main window open
displaying the Messages Sent tab.

 The Messages Sent tab will display a database record of all of the previously sent
text messages as a table.

 There are four columns within the Messages Sent table. These are: blank (if there is
an error returned from SMSC then this field will display ‘ERR’, the Name column
(where the name or number of the message recipient is displayed), the Date/Time
column (that records the date and time that the message was sent) and the SMS
message column (where the text content of the message is recorded).

If you used a Phone Book entry when sending your text message, the
corresponding name will appear in the Name column. If you entered a GSM
number manually however, then only the number will be shown in the Name
column. If there is an error when sending the message first column will have
displayed ‘ERR’ to indicate that message has not been sent successfully.

 The Messages Sent table will record sent text messages in chronological order. The
most recently sent message will be displayed on the top row and the oldest message
will be displayed at the bottom. Messages with ‘ERR’ will be displayed on the top.

 There are four rows within the Messages Sent table. If your table contains
more than four messages, you may use the scroll bar on the right-hand side
of the table to scroll up and down.

Use the Go to Top button to return to the top of the table.
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 You may select an entry by clicking on the left-hand side of the table adjacent to the
entry or by clicking on the entry itself. This will mark the selected entry and will keep
the table position when switching between tabs.

You can use the Copy command on the Messages Sent table.

 Text message records remain in the table until they are manually deleted.
To delete a single record, first select the record as described above and
click on the Delete current record button. You will be asked to confirm your
action by the DeskTop.SMS table update  window. If you click on Yes, this
will irreversibly remove the current
record from the database. If you click
on No, you will return to the Messages
Sent tab without having deleted the
record.

If you try to delete without having selected a record, DeskTop.SMS will report that
there is Nothing to delete!. Please select a record before you click on the Delete
current record button.

 If you wish to delete all of the records in the Message Sent table, click on
the Delete all records button. You will be asked to confirm your action by
the Messages Sent table update  window. If you click on Yes, this will
irreversibly remove all records from the database. If you click on No, you
will return to the Messages Sent
tab without having deleted any
records.

Important. Deleted records CANNOT be restored. Please ensure you have a
sufficient backup copy of the records before you delete them. For information on
backing up your records, please refer to section 12.2.
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4. Receiving Text Messages
DeskTop.SMS will receive SMS text messages automatically.

At predefined intervals, DeskTop.SMS checks the SIM card in your TWIST GSM modem for
new messages. If it finds a new text message, it will report that a New SMS has arrived.
Would you like to read it now?.

Clicking on the Yes option will open the newly
arrived text message in the Messages Received tab.

Clicking on No will not open the message
immediately, though it will remain in the Messages
Received table for viewing at a later convenience.

Important. For DeskTop.SMS to be able to receive new SMS text messages, you
must have both the TWIST GSM modem on and have the DeskTop.SMS
application running. DeskTop.SMS must be able to poll the modem to collect new
text messages from the SIM card.

DeskTop.SMS may be run minimised (i.e. in background memory) whilst you
access other applications, and will "pop-up" on a new delivery of SMS text
messages.

If you close the DeskTop.SMS application and the TWIST GSM modem receives new text
messages during this time, these messages will remain on the modem SIM card and will not
be able to be accessed until you restart the software.
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4.1 Viewing the List of Received Text Messages

To view the list of received text messages, please follow this procedure:

 Have the DeskTop.SMS main window
open displaying the Messages
Received tab.

 The Messages Received tab will display a database record of all of the received text
messages as a table.

 There are three columns within the Messages Received table. These are: the Name
column (where the name or number of the message sender is displayed), the
Date/Time column (that records the date and time that the message was sent) and
the SMS message column (where the text content of the message is recorded).

Note that the unread messages are highlighted and bold. Once click anywhere on
the row will change to normal and indicate that message has been read.
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If the GSM number of the sender corresponds to Phone Book
entry, their name will appear in the Name column. If not,
then only the GSM number will be shown.

 The Messages Received table will record received text messages in chronological
order. The most recently received message will be displayed on the top row and the
oldest message will be displayed at the bottom.

 There are four rows within the Messages Received table. If your table
contains more than four messages, you may use the scroll bar on the right-
hand side of the table to scroll up and down.

Use the Go to Top button to return to the top of the table.

 You may select an entry by clicking on the left-hand side of the table adjacent to the
entry or by clicking on the entry itself. This action will mark the selected entry and
will keep the table position when switching between tabs.

You can use the Copy command on the Messages Received table.

 Text message records remain in the table until they are manually deleted.
To delete a single record, first select the record as described above and
click on the Delete current record button. You will be asked to confirm your
action by the DeskTop SMS table update  window. If you click on Yes, this
will irreversibly remove the current
record from the database. If you click
on No, you will return to the Messages
Received tab without having deleted the
record.

If you try to delete without having selected a record, DeskTop.SMS will report that
there is Nothing to delete!. Please select a record before you click on the Delete
current record button.
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 If you wish to delete all of the records in the Message Received table, click
on the Delete all records button. You will be asked to confirm your action by
the Messages Received table update  window. If you click on Yes, this will
irreversibly remove all records from the database. If you click on No, you
will return to the Messages
Sent tab without having
deleted any records.

Important. Deleted records CANNOT be restored. Please ensure you have a
sufficient backup copy of the records before you delete them. For information on
backing up your records, please refer to section 12.2.

4.2 Changing the Refresh Time

As described previously, new SMS text messages are delivered over the mobile network to
the TWIST GSM modem SIM card. DeskTop.SMS polls the modem at predefined intervals to
check to see if any new text messages have been received.

The interval period between polling is set to 30 seconds as default. During that
period, DeskTop.SMS will report that modem polling is Idle .

At the end of 30 seconds, the modem will be polled and DeskTop.SMS will report
that it is Running .

If any new messages are found, DeskTop.SMS will copy and remove the information from
the SIM card and enter it into the Messages Received database.

If you wish to change the interval period between modem polling, please follow this
procedure:

 Have the DeskTop.SMS main window open and locate the Set
refresh time variable.

 Using the up and down arrows (or by typing manually), modify the refresh time to a
value that suits.

 The range for the refresh time is 0 to 60 seconds. If you try to enter a value that is
outside of this range, DeskTop.SMS will report Range: 0 to 60 indicating that you
must enter an appropriate number to continue.

Setting the Refresh time to 0 will instruct DeskTop.SMS to disable polling the
modem SIM card for incoming messages. You may however send out SMS
messages.
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5. Exporting Message Records
All of the text messages in the Messages Received and Messages Sent tables can be
exported to an external file.

Exporting your message database is a useful way of backing-up your text message
correspondence for future reference.

All files are exported in .XLS spreadsheet format to be compatible with Microsoft Excel.

5.1 Exporting Received Message Records

To export the Messages Received database to an .XLS file, please follow this procedure:

 Have the DeskTop.SMS main window open and
click on the File menu. Select the Export
Received Log to XLS  option. Alternatively,
simply press CTRL-R.

 The Export Messages Received log screen will
ask you to verify the export action. Click on OK
to continue or click on Close to exit without
exporting.

 DeskTop.SMS will always export the Messages Received database file to the root
folder where you installed the application (e.g. C:\Program Files\DeskTop_SMS by
default). You cannot change the location of the export.

 DeskTop.SMS will report Export completed successfully and stored as Excel XLS file
C:\Program Files\DeskTop_SMS\InSMS_29042002_1.XLS.

Exported filename definition: InSMS = from the Messages Received database,
29042002 = the date in DDMMYYYY format and 1 = part 1 (note that 2 parts are
only generated when an extremely large number of records are exported).
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If there are no records in the Messages Received database and
you try to export, DeskTop.SMS will report that there is Nothing
to Export! and will not perform the action.

 Check in the folder for the exported file and view in Microsoft

Excel.

Examining the export file, you will notice that there are four columns:

 The name column is a list of the names of the senders as found in the Phone Book. If
the sender does not have a Phone Book entry, this cell will be left blank.

 The phoneno column is a list of the GSM phone numbers of the senders.

 The smsdatetime column is a list of the dates and times that the messages were
received (in MM/DD/YYYY hh:mm:ss format).

 The smstext column is a list containing the contents of the received text messages.

5.2 Exporting Sent Message Records

To export the Messages Sent database to an .XLS file, please follow this procedure:

 Have the DeskTop.SMS main window open and
click on the File menu. Select the Export Sent
Log to XLS  option. Alternatively, simply press
CTRL-S.

 The Export Messages Sent log screen will ask
you to verify the export action. Click on OK to
continue or click on Close to exit without
exporting.
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 DeskTop.SMS will always export the Messages Sent database file to the root folder
where you installed the application (e.g. C:\Program Files\DeskTop_SMS by default).
You cannot change the location of the export.

 DeskTop.SMS will report Export completed successfully and stored as Excel XLS file
C:\Program Files\DeskTop_SMS\Outsms_29042002_1.XLS.

Exported filename definition: Outsms = from the Messages Sent database,
29042002 = the date in DDMMYYYY format and 1 = part 1 (note that 2 parts are
only generated when an extremely large number of records are exported).

If there are no records in the Messages Sent database and you
try to export, DeskTop.SMS will report that there is Nothing to
Export! and will not perform the action.

 Check in the folder for the exported file and view in Microsoft Excel.

Examining the export file, you will notice that there are four columns:

 The name column is a list of the names of the recipients as found in the Phone Book.
If the recipient does not have a Phone Book entry, this cell will be left blank.

 The phoneno column is a list of the GSM phone numbers of the recipients.

 The smsdatetime column is a list of the dates and times that the messages were sent
(in MM/DD/YYYY hh:mm:ss format).

 The smstext column is a list containing the contents of the sent text messages.

Text messages sent as part of a Phone Book group entry will be listed in the
export file individually (i.e. since they were sent to each individual separately).
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6. The Phone Book
The DeskTop.SMS Phone Book is used to store the names and numbers of your contacts.

To access the Phone Book, please follow this procedure:

 Have the DeskTop.SMS main window open and
click on the File menu. Select the Phone Book
option (or simply press CTRL-N).

 You may also open the Phone Book by clicking on the Phone Book
button on the main window.

 The Phone Book window is illustrated as follows:

By using the Phone Book window, you may create, edit, delete, sort, import, export and
print entries from the list of contacts.



In s ta l l at ion  and  User  Manual 32/75

6.1 Creating a New Phone Book Entry

To create a new Phone Book entry, please follow this procedure:

 Have the Phone Book window open and click on the Add New Record
button. This will open up the entry fields.

 In the Name field, please enter the name of the contact (maximum 40 characters).

 In the Phone No field, please enter the GSM mobile phone number of the contact
(maximum 15 numbers).

Important. Please ensure that the GSM number entered is in the standard
international format (e.g. +61404818783 instead of 0404818783). Generally,
most numbers require a country code and the omission of the leading 0 digit.
Please refer to section 12.1 for international dialling code numbers.

 You can assign up to 4 different groups to a person. From the the Group field, please
select the name of the group from the drop-down list. To create a group, you will
need to open form PhoneBook – Groups from the
menu. To select an existing group, click on the Group
box arrow and select a group name.

 To remove the person from the group just select the blank record from the drop-
down list. This applies to Group 1 to Group 4 fields. To clear the values entered in
other fields just select and press delete key from your keyboard or use the
backspace.

 Once all of the required contact information has been entered, you may
save the entry by clicking on the Save button. This action will update the
Phone Book contact list and display your new entry.
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 To exit the Add New Record function without saving any changes,
click on the Undo button.

Each individual Phone Book entry must have a unique GSM mobile phone number.
You may have two entries with the same name but you may not have two entries
with the same GSM number. If you try to save an entry with a duplicate GSM
number, DeskTop.SMS will report Phone Number must be unique! and you must
enter a new number.

 If you need to add new group in the Group drop-
down list you will have to use form PhoneBook –
Groups from the main menu.

 Form PhoneBook – Groups looks like on
the picture

  To Add a new unique groupname record click on Add button and after typing the
name just press Save button. If groupname you have just entered already exists
DeskTop.SMS will notify you and prompt you to enter another name.
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 Saved record ( new groupname ) looks like bellow

    To Delete the groupname record select the record and then click on Delete button
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6.2 Editing a Phone Book Entry
To edit a Phone Book entry, please follow this procedure:

 Have the Phone Book window open and simply double-click on the entry you wish to
edit.

 This will open up the entry fields.

 You may now directly edit the entry fields and make changes.

 Once all of the editing has been completed, you may save the entry by
clicking on the Save button. This action will update the Phone Book contact
list.

 To exit from the editing function without saving any changes, click on the
Undo changes button.



In s ta l l at ion  and  User  Manual 36/75

6.3 Deleting a Phone Book Entry

To delete a Phone Book entry, please follow this procedure:

 Have the Phone Book window open and click on the entry
you wish to delete.

 Click on the Delete current record button. You will be asked to confirm
your action by the PhoneBook table update  window. If you click on Yes,
this will irreversibly remove the current entry from the Phone Book. If
you click on No, you will return to the Phone Book without having deleted the entry.

If you try to delete without having
selected a record, DeskTop.SMS will
report that there is Nothing to
delete!. Please select a record before
you click on the Delete current record
button.

Important. Deleted entries CANNOT be restored. Please ensure you have a
sufficient backup copy of your contacts before you delete them.

6.4 Deleting All of the Phone Book Entries

To delete a Phone Book entry, please follow this procedure:

 Have the Phone Book window open and click on the Delete all records
from the PhoneBook button. You will be asked to confirm your action by
the PhoneBook table update  window. If you click on Yes, this will
irreversibly remove all entries from the Phone Book. If you click on No, you will
return to the Phone Book
without having deleted
any entries.

Important. Deleted entries CANNOT be restored. Please ensure you have a
sufficient backup copy of your contacts before you delete them.
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6.5 Sorting the Phone Book Entries

There are two ways of viewing the Phone Book entries: the first is by ascending/descending
column values (e.g. names organised alphabetically) and the second is in their "natural
order" (i.e. the order in which they were created).

DeskTop.SMS will report which sorting order is currently
enabled at the bottom left-hand corner of the window
(e.g. Ordered by  Name ascending).

To view the Phone Book entries in ascending/descending column values, please follow this
procedure:

 Have the Phone Book window open and move the mouse to the top of the columns.

 Click on a top column bar (e.g. Name) and DeskTop.SMS will sort the column entries
for you in ascending order.

 Click on the top column bar again and the order will be reversed (i.e. descending).

Try sorting the Phone No, Groupname columns in the same fashion.
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To view the Phone Book entries in the order in which they were created (i.e. to return them
to their "natural state"), please follow this procedure:

 Have the Phone Book window open and click on the z No order
button.

 This action will cause the Phone Book to sort the contact entries into the order in
which they were created.

The entries created first will be at the top of the table, while the latest will be
found at the bottom. This sorting function is ideal for manually checking newly
imported contact details (for information on importing contact details, please refer
to sections 6.6 and 6.7).

Please note that it is not possible to change the row height or column width in the
Phone Book table.
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6.6 Exporting Phone Book Entries

All of the contacts in the Phone Book can be exported to an external file.

Exporting your Phone Book database is a useful way of backing-up your contact information
for future reference.

The export file will be in .XLS spreadsheet format and is compatible with Microsoft Excel.

To export the Phone Book contact database to an .XLS file, please follow this procedure:

 Have the Phone Book window open and click on the Export to Excel
(.XLS) button.

 DeskTop.SMS will export the contact database file to the root folder where you
installed the application (e.g. C:\Program Files\DeskTop_SMS by default). You
cannot change the location of the export.

 DeskTop.SMS will report Result exported successfully to Excel as C:\Program
Files\DeskTop_SMS\phonebook.XLS.

If there are no records in the Phone Book database and you
try to export, DeskTop.SMS will report that the Phone Book is
empty. Nothing to Export! and will not perform the action.

 Check in the folder for the exported file and view in Microsoft Excel.

Examining the export file, you will notice that there are six columns:

 The groupname..4 columns are list of the group names as found in the Phone Book.

 The name column is a list of the names of the contacts.

 The phone_number column is a list of the GSM mobile phone numbers of the
contacts.
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6.7 Importing Phone Book Entries (Outlook)

Importing existing contacts is an economical way of generating DeskTop.SMS Phone Book
entries.

To import entries from your Microsoft Outlook Contacts folder(s), please follow this
procedure:

 Have the DeskTop.SMS main window open and click on the
Admin button.

 DeskTop.SMS will display Opening Admin form Please
wait whilst it is loading the Administration window.

 When the Administration window has loaded,
look at the right-hand side of the window for
the import controls. Click on the Check
Outlook® button to instruct DeskTop.SMS to
find your Contacts folder.

DeskTop.SMS can only import contacts from Microsoft Outlook and not from
other e-mail clients such as Microsoft Outlook Express or Eudora.

 DeskTop.SMS will now display Searching for
Outlook Contacts folders .

If you have an empty Microsoft Outlook Contacts folder and
instruct DeskTop.SMS to check for entries, it will report that
there is Nothing to import!. You must have contact entries in the
Contacts folder to be able to import into the Phone Book.

If you do not have a copy of Microsoft

Outlook installed and yet instruct
DeskTop.SMS to check for Contacts folder
entries, it will report that there is Nothing to
Import! and will disable the import controls.

 Once DeskTop.SMS has found the Contacts folder,
it will display Drop down list updated. Ready for
import.

 You may now select the folder containing the contacts
you wish to import from the List in Public Folders drop
down box.
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If you have more than one sub-folder in your Microsoft®

Outlook® Contacts file, you may select either the entire
folder or alternatively, select a single sub-folder using
the drop down box.

If you have a large number of different Contact
folders and/or your Personal Folder File (.PST)
resides on a network share, it is recommended that
you create a new Contacts sub-folder locally on your
PC and copy all of the entries into it that you wish to
import into DeskTop.SMS. You may then select the
sub-folder when importing to DeskTop.SMS and be
precise as to which contact entries you will import.

 Now you must click on the Import Contacts from
Outlook® button to proceed with the import process.

 DeskTop.SMS will now count the number of entries in
the Contacts folder. It will inform you that it has Found
X contacts in Contacts folder.

 DeskTop.SMS will now check these contacts
for their GSM mobile phone numbers and
will report Total contracts with Mobile No.s
X in Contracts folder.

DeskTop.SMS will only import contacts that have a corresponding mobile phone
number. If for example, you try to import 100 contacts but none of these has a
mobile phone number, DeskTop.SMS will not create
any new Phone Book entries.
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Try assigning entries in your Microsoft Outlook

Contacts folder with categories. DeskTop.SMS will
recognise these categories during an import and
create the appropriate Phone Book Groupnames for
you. Please note that DeskTop.SMS will only import
one entry per GSM mobile phone number and that
multiple entries with identical numbers are not
allowed.

 DeskTop.SMS will now copy these contacts across to the
Phone Book and will report Phone Book refreshed .

 Click on the Exit the form button to leave the Administration
window.

 Back on the DeskTop.SMS main window, click on the Phone Book
button.

 The Phone Book window will now
open and display your newly
imported contacts.

You may now assign groups to the newly imported contacts by double-clicking on
the individual entries and directly editing them.

 You can now use the imported Phone Book entries to send SMS text messages.
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6.8 Importing Phone Book Entries (.CSV)

Importing existing contacts is an economical way of generating DeskTop.SMS Phone Book
entries.

To import entries from a comma-separated (.CSV) file, please follow this procedure:

 Have the DeskTop.SMS main window open and click on the
File menu. Select the Import from CSV File  option.

 This will open the Import
contacts from CSV file
window.

 Click on the Import into temporary table button
to enable the Open window. Using this window,
select the .CSV file from which you wish to import
your contacts.

Important. To correctly import .CSV files into the DeskTop.SMS Phone Book,
they must contain at least 3 fields separated by commas. The first field must be
the Name of the contact, the second must be the PhoneNo and the third, fourth,
fifth and sixth the Groupnames.
     I.e.   "Name", "PhoneNo", "Groupname"
For example,  "Jocic, Dejan","+61414457256","MOBILEIT (DEVELOPMENT)"
   "Chris Hall","+447976364025","COMMS XL LIMITED"
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Please note that DeskTop.SMS will always ignore the contents of the first line of a
.CSV file (i.e. the line usually occupied by the field descriptions).

 Example below shows how the .CSV file for importing should look like.

Important thing is that your .CSV file have columns in this order i.e.
first column corresponds to names field in DeskTop.SMS
second column corresponds to Mobile Phone No field in DeskTop.SMS
third column corresponds to Group1 field in DeskTop.SMS
fourth column corresponds to Group2 field in DeskTop.SMS
fifth column corresponds to Group3 field in DeskTop.SMS
sixth column corresponds to Group4 field in DeskTop.SMS

If you try to import a file that contains no records,
DeskTop.SMS will report that the Selected .CSV is
empty. Nothing to import. Please select a file that
contains some entries and try again.

 Once you have selected your .CSV file, click on the Import button.

 DeskTop.SMS will now scan the file for contact entries and will report X records
imported successfully from CSV file into
temporary table!.

 The Temporary table is used to
illustrate how imported contact
entries would look when you
import them into the Phone
Book.
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If the imported .CSV file does not fill the columns as was expected, or if the
information is in the wrong place, please exit the window and modify the .CSV file
(to mimic format shown above). Now try to load the file again.

Please note that during checking if two (or more) entries in the .CSV file have
identical GSM phone numbers, the preceding entry will be overwritten by the
following and treated as one record only. Also note that any entries in the checked
.CSV file that have the same GSM number as an existing Phone Book contact, will
overwrite their Phone Book counterparts.

 Once you are satisfied with the layout of the imported contacts
on the Temporary table and you wish to import them into the
Phone Book, click on the Import into Phone Book button.

 DeskTop.SMS will now copy the
checked records in the Temporary table
to Phone Book entries and will report
that X records imported successfully
from CSV file into PhoneBook!.

  The Import contacts from CSV
file window will now display all
of the contacts that were
imported into the Phone Book.

Please note that DeskTop.SMS will only import entries into the Phone Book if they
have a GSM mobile phone number (in international format) entered in the
Phoneno field.

 The import function has now been completed. Click on the Close
button to exit and return to the DeskTop.SMS main window.

 You can now use the imported Phone Book entries to send SMS
text messages.
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6.9 Printing the Phone Book Entries

The Phone Book entries may be printed to a printer connected to your PC. The printer may
be either local or network mapped, but must be set as the default.

To print the Phone Book entries, please follow this procedure:

 Have Phone Book window open and click on the Print button.

 The Report Designer window
will now open and display a
print preview of the Phone
Book. When you are ready to
print the Phone Book, click on
the Print button. A copy of the
Phone Book entries will now be
sent to the default printer.

 To close the print preview, click on the Exit button.

You may print the Phone Book entries
more directly (i.e. without having to open
the preview), by right clicking on the
Print button to open the Print window.
Click on OK to send a copy direct to the
default printer (or choose a different
location).
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6.10 Using the Phone Book Entries

All Phone Book entries are repeated in the Contact box on the bottom left-hand corner of
the DeskTop.SMS main window.

Using the Individual/group contact selection buttons, you may switch views in the Contact
box as follows:

 Click on the Individuals button, and DeskTop.SMS will
arrange the Contact box such that only individual
contacts are shown.

 Click on the Groups button, and DeskTop.SMS will
arrange the Contact box so that all of the contacts
groups are shown.

 Click on the All button, and DeskTop.SMS will display
both individual and group contact together in the
Contact box.
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To use the Phone Book entries to send text messages, please follow this procedure:

 Select the contact you wish to send the text message to by clicking on their
corresponding entry in the Contact box. You may do this by moving your mouse over
and clicking on the entry.

You may select more that one contact at once by using the mouse combined with
the CTRL or SHIFT keys.

If you have a large number of contact entries in the Contact box, use the
scroll bar to scroll up and down.

 Now you must move the entry from the Contact box over to the Recipient
Box. To do this you must either double-click (single contact only) or drag
the entry over. You may also use Add Selected Items button to transfer
your selection.

 To remove any entries you have moved over to the Recipient box, you must
select them and click on the Remove Selected Items button.
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 To move all of the contacts from the Contact box to the Recipient box, you
must click on the Add All Contacts button.

 To remove all of the contacts from the Recipient boxback to the Contact
box, you must click on the Remove All Contacts button.

You may use the Contact boxto
create a combination of groups and
individuals to whom you wish to
send your message.

 You must now compose your message and click on the Send
button. DeskTop.SMS will send a copy of the text message to
each of the recipients in the Recipient box.

Important. When sending text messages to a number of contacts (or as a
group), your mobile phone network will charge you for each delivery.
For example, if you send a text message to a group containing 20 contacts,
DeskTop.SMS will send out 20 individual messages
and you will be charged by your operator for each of
those sent.
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7. The File Menu
The File menu contains a series of commands used to
perform functions in DeskTop.SMS.

Some commands have a corresponding button on the
DeskTop.SMS main window, whilst some are only to be found
on this menu.

The File menu options are described as follows:

7.1 Phone Book

This File menu command is used to activate the DeskTop.SMS
Phone Book.

Please refer to section 6 for information on using the Phone
Book.

7.2 Quick SMS

This File menu command is used to create Quick SMS
messages.

Quick SMS messages are pre-typed and stored to save you
having to type them out manually every time you send a text
message.
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To create a Quick SMS message, please follow this procedure:

 Click on the Quick SMS option on the File menu. This will open the Pre-typed SMS
messages window.

 Click on the Add new record button. This will activate the Composure box
in which you may type the contents of your Quick SMS message.

You can use the Cut, Copy and Paste commands in the Composure
box. Enter a maximum of 160 digits. SMS text messages do not
allow "Enter"/carriage-returns.
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 To exit the from the Add New Record function without saving any changes,
click on the Cancel changes button at the top of the window.

 Once you have finished typing out your message, click on the Save/Update
changes button.

 Your Quick SMS message will now be stored. Click on the Exit button to close the
Pre-typed SMS messages window.
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 To delete a stored Quick SMS message, click on the Delete current record
button. You will be asked to confirm your action by the QuickSMS table
update  window. If you click on Yes, this will irreversibly remove the
current pre-typed message. If you click on No, you will return without
having deleted the message.

 To delete all stored Quick SMS messages, click on the Delete all records
from table button. You will be asked to confirm your action by the
QuickSMS table update  window. If you click on Yes, this will irreversibly
remove the all pre-typed messages. If you click on No, you will return
without having deleted
any messages.

 On the DeskTop.SMS main window, you can now select your pre-typed text message
from the Select quick type SMS box. Click on your entry to instruct DeskTop.SMS to
automatically fill the Composure box for you.

You may have an unlimited number of stored Quick SMS messages.
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7.3 Scheduled SMS(s)

This File menu command is used to view scheduled text
messages.

To send a scheduled SMS text message using DeskTop.SMS, please follow this procedure:

 Have the DeskTop.SMS main window open
displaying the New Message tab.

 Type your text
message using the
Composure box.

 Once you have a text message that is ready to send, you must now select the
recipient(s) of the text message. You may send the message to an individual, a pre-
defined group or a mixture of
individual/group entries.

 To type the recipient number, click on the GSM No.
field and enter the number of the mobile phone to
whom you wish to send your text message.

 Now you must inform DeskTop.SMS that you wish to schedule
the text message by clicking on the Schedule option on the
main window.

 This will activate the date/time field on the top right-hand
side of the New Message tab. In this field enter the date
and time you wish to send the new text message.

You must enter valid digits in the date/time field (in DD-MM-YYYY hh:mm:ss
format). For example, if today's date and time is the 26th April 2002 9:45am
(26-04-2002 09:45:00) and you wish to schedule a text message to be sent this
afternoon at 2pm, you must enter 26-04-2002 14:00:00.
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 You may now send the text message by clicking on the Send
button.

If DeskTop.SMS reports Invalid Date/Time when you click on Send, you have
entered an incorrect date and/or time for scheduling. The date
and time must be in DD:MM:YYYY hh:mm:ss and contain valid
digits (e.g. 32:01:2002 is not a valid date).

If DeskTop.SMS reports Scheduled send date/timemust be greater than current
date/time! Please try again , then you have entered a time that is equal to the
current or has already passed (e.g. if the current date and time is 26th April 2002
9:45am and you try to enter 26th April 2002 8:15am).

 If the text message was scheduled
successfully, DeskTop.SMS will
present the summary window and
report SMS scheduled to send on:
DD-MM-YYYY hh:mm:ss to X users.

 To view your new scheduled message, click on the File menu and select the
Scheduled SMS(s)  option. DeskTop.SMS will present the Scheduled SMS(s)
window.

 There are four columns within the Scheduled SMS(s) table. These are: the Name
and/or GSM number column (where the name and/or number of the message
recipient is displayed), the Group column (where the group to which the recipient
belongs is displayed), the Date/Time column (that records the date and time that the
message will be sent) and the SMS message column (where the text content of the
message is recorded).
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 The Scheduled SMS(s) window displays the total
number of text messages that you have scheduled
in the top-right hand corner.

 To delete a scheduled message, click on the Delete current record
button. You will be asked to confirm your action by the Scheduled SMS
table update  window. If you click on Yes, this will irreversibly remove
the current scheduled message. If you click on No, you will return
without having deleted the
message.

 To delete all scheduled messages, click on the Delete all records from
table button. You will be asked to confirm your action by the QuickSMS
table update  window. If you click on Yes, this will irreversibly remove
the all pre-typed messages. If you click on No, you will return without
having deleted any messages.
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7.4 Export Received Log to XLS

This File menu command is used to export the Messages
Received database to a Microsoft Excel .XLS file.

Please refer to section 5.1 for information on exporting
received text messages as a log file.

7.5 Export Sent Log to XLS

This File menu command is used to export the Messages Sent
database to a Microsoft Excel .XLS file.

Please refer to section 5.2 for information on exporting sent
text messages as a log file.

7.6 Import from CSV File

This File menu command is used to import Phone Book contact
details from a comma-separated (.CSV) file.

Please refer to section 6.8 for information on generating and
importing .CSV files into the Phone Book.

7.7 Exit

This File menu command is used to exit the DeskTop.SMS
application.

Important. If you exit the DeskTop.SMS application, you will not be
able to send or receive SMS text messages. If you wish to hide the
application and still be able to receive text messages, minimise it to
the Taskbar.
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8. The Help Menu

8.1 DeskTop.SMS Help Topics

This Help menu command is used to display the
DeskTop.SMS Help file.

The Help file is an electronic version of this user manual
designed to assist you when using the DeskTop.SMS
application.

8.2 Display My GSM Number

This Help menu command is used to display the
subscriber number of your TWIST GSM modem SIM
card.

Your subscriber number is simply the mobile phone
number personally issued to you by your network
operator when you subscribed to their service (e.g.
+61404818783).

The Display my GSM number  command stores a record of your number for future
reference.

This Help menu command is particularly useful when you wish to use your own number in
text message correspondence.
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To view, record or modify your personal GSM number, please follow this procedure:

 Click on the Display my GSM number  option on the Help menu. This will open the
Subscriber (GSM) Number window.

 To record your personal number, click on the
Edit button. This will activate the number
field.

 Enter your GSM number exactly; making sure
that it is in the standard international format
(i.e. +61404818783 and not 0404818783)
that it has at least 10 digits.

 Click on the Save button to store your GSM number. Alternatively, you may quit the
activated number field without updating by clicking on the Undo button. Please note
that the Exit button will be disabled until you have clicked on either of the
aforementioned buttons.

 Once you have stored your GSM number, you may refer to it at any
time and use the Copy command (right-click or CTRL-C on the
selected numbers) to transfer and use it in your text message.

 Click on Exit to close the Subscriber (GSM) Number field.
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8.3 Register Your Copy

This Help menu command is used to open the
Registration form window.

The Registration form window is used to register your
copy of DeskTop.SMS.

If your copy of DeskTop.SMS has been already
registered, it will display the details of your licence for reference.

For information regarding registration, please refer to section 2.6.

8.4 About DeskTop.SMS

This Help menu command is used to open the
DeskTop.SMS About window.

The About window contains copyright information and
DeskTop.SMS technical data.

To view the About window, please follow this procedure:

 Click on the About DeskTop.SMS  option on the Help menu. This will open the About
window.

 The Technical Data section is used by MobileIT to identify and troubleshoot your copy
of DeskTop.SMS.
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9. Administering DeskTop.SMS
DeskTop.SMS is administered via the application parameters found on the Administration
window.

To administer DeskTop.SMS, please follow this procedure:

 Click on the Admin button on the main window to open the Administration window.

 Using the parameters found on this window, you are able to modify and test
DeskTop.SMS functions and settings.

9.1 Changing the COM Port…

The COM port is simply a 9-pin serial communications port (found on the rear of most PCs)
that connects the PC to the TWIST GSM modem using a cable. There is usually more than
one COM port, so you must instruct DeskTop.SMS to chose the one on which you have
installed your TWIST GSM modem.

To change the COM port, please follow this procedure:

 Click on the COM port box on the Admin window.
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 Select the COM port on which your TWIST GSM modem is attached
from the drop down box.

The default COM port value is set to COM1 and may be changed
to any serial port number between COM1 and COM10. Under
most circumstances however, the likely serial port to which the
TWIST GSM modem is attached will be either COM1 or COM2.

 The COM port number has now been modified. Click on Save to store the change and
close the Admin window with the Exit button.

If you wish to verify that DeskTop.SMS can communicate with the TWIST GSM
modem after changing the COM port number, re-open the Administration window.
If it opens without displaying COM port doesn't exist or modem is not properly
conencted!, you have successfully changed the COM port number. To double-
check, confirm that DeskTop.SMS is sending AT commands to the modem in the
Output commands box (lower left-hand side of the Administration window).

9.2 Changing the Baud Rate…

The baud rate is simply the speed of the data transferral between the PC and the TWIST
GSM modem.

To change the baud rate that DeskTop.SMS is using whilst communicating with the modem,
please follow this procedure:

 Click on the Baud rate box on the Admin window.

 Select the baud rate from the drop down box.

The default baud rate value is set to 9600 and may be changed
to either 2400, 4800, 9600 or 19200. Please note that unless you
intend to install a different GSM modem than the TWIST, you will
not need to change this value.

 The baud rate has now been modified. Click on Save to store the change and close
the Admin window with the Exit button.
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9.3 Changing the SMSC Number…

The SMSC (Short Message Service Centre) number is the number of the message centre of
the mobile phone network operator. The message centre is where all SMS text messages
are relayed. You must ensure you have the correct SMSC number for your network provider
or you will not be able to send or receive text messages.

To change the SMSC number, please follow this procedure:

 Click on the SMSC No. box on the Admin
window.

 Select the appropriate SMSC number from
the drop down box or manually enter the
number in the activated field.

DeskTop.SMS will automatically read the SMSC number from the SIM card (found
in the TWIST GSM modem) and will present the SMS Provider Name. Under most
circumstances, you should not have to modify this SMSC number.

 The SMSC number has now been modified. Click on Save to store the change and
close the Admin window with the Exit button.

9.4 Changing the Startup Delay and Response Time…

Important. The Startup Delay and Response Time settings are used to modify
the performance of DeskTop.SMS and should only be changed under instruction
from MobileIT. By default, the Startup Delay is set
to 1.0 and the Response Time is set to 1000.
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9.5 Importing Phone Book Entries (Outlook)…

Importing existing contacts is an economical way of generating DeskTop.SMS Phone Book
entries.

The Administration window is used to import external
contacts from Microsoft Outlook.

To import entries from your Microsoft Outlook

Contacts folder(s), please refer to section 6.7.

9.6 Changing the Country Code…

The Country Code is simply the standard international dialling number of the country in
which you are running DeskTop.SMS.

DeskTop.SMS will use the Country Code number to correct numbers you enter in the GSM
No. field that are not in the standard international format.

For example, if you send a text message in Australia to an Australian GSM number
040481873, DeskTop.SMS will automatically remove the leading 0 digit and replace it with
+61, thus correctly sending the message out to +61404818783.

To change the Country Code, please follow this procedure:

 Click on the Country Code field on the Admin window and type your number.

The Country Code number is the standard international dialling code for your
country (as found in section 12.1) and you must omit the plus (+) symbol when
entering the number in this field. For example, the international dialling code for
Australia is +61; you must therefore enter 61 into the Country Code field.

 The Country Code has now been modified. Click on Save to store the change and
close the Admin window with the Exit button.

9.7 Changing the International Dialling Codes…

The International Dialling Codes are standard international dialling numbers.

DeskTop.SMS will use the International Dialling Codes to correct GSM mobile phone
numbers you have imported from your Contacts folder.

For example, if you import a contact with a British GSM number 0011447976364025 and
have entered 0011 as an International Dialling Code; DeskTop.SMS will automatically
remove the leading 0011 digits and ensure that it has a leading plus (+) symbol, thus
correctly saving the contact number in the Phone Book as +447976364025.



In s ta l l at ion  and  User  Manual 65/75

To change the International Dialling Codes, please follow this procedure:

 Click on the IDC 1, IDC 2 and IDC 3
fields on the Admin window and type
your numbers.

You may store up to three International Dialling Code numbers to correct
imported contacts.

Important. Please ensure you are comfortable with the format of the GSM
numbers in your phone book before you enter values in the IDC fields. As a rule,
DeskTop.SMS will remove any leading digits from the imported contacts that are
identical to the ones you have entered in the IDC fields. It is recommended that
you keep 0011 entered in IDC 1.

 The International Dialling Codes have now been modified. Click on Save to store the
change and close the Admin window with the Exit button.

9.8 Sending a Test SMS Text Message…

You may use the Administration window to send a test SMS text message and monitor it
using the Output commands box.

To send a test text message, please follow this procedure:

 On the Admin window, enter the GSM mobile phone number of the message recipient
in the GSM No. field.

Important. Please ensure that the number entered is in the standard
international format (e.g. +61404818783 instead of 0404818783). Generally,
most numbers require a country code and the omission of the leading 0 digit.
Please refer to section 12.1 for international dialling code numbers.

 Type your text message using the Composure box. Please note that SMS text
messages allow a maximum of 160 characters per message and do not allow
"Enter"/carriage-returns.

 Now you may send the text message by clicking on the Send button. This instructs
DeskTop.SMS to initialise the GSM modem and send your text message over the
mobile phone network.

 You can monitor the sending process by watching the AT commands issued by
DeskTop.SMS to the TWIST GSM modem in the Output commands box.
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9.9 Running DeskTop.SMS in Test Mode…

DeskTop.SMS has a Test Mode function that when enabled, allows you to monitor the output
commands to the TWIST GSM modem.

The Test Mode function is useful for troubleshooting and administration purposes.

To activate the Test Mode, please follow this procedure:

 Have the DeskTop.SMS main window open and click on the Test Mode
check box so that it appears checked.

 This will activate the Modem
output commands window. You
will observe DeskTop.SMS
issuing AT commands to the
TWIST GSM modem when
active.

 A typical series of AT commands issued by DeskTop.SMS when sending a text
message is as follows:

ATV1Q0E1 Result code format.

OK
AT+CMGF=1 SMS message format.

OK
AT+CSCA="+61415011501" SMS service centre address.

OK
AT+CMGS="+61404818783" Send SMS message (to recipient number).

> Mike, please phone the office ASAP. Message contents.
+CMGS: 231

OK

 Once you have finished monitoring modem command traffic, close the Test Mode
window by clicking on the Test Mode check box so that it appears un-checked.

The Modem output commands window performs the same function as the
Administration window equivalent.

The AT commands viewed in the Modem output commands window are part of a
line-orientated command language used on communications devices. Each
command contains three elements: the prefix, the body and the termination
character. The prefix is simply AT, the body is made of varying characters that
define the command (e.g. +CMGF=1) and the termination character identifies the
end of the command (usually hidden).
Commands are acknowledged with an OK (to signal that the command was a
success) or with an ERROR (to signal that the command was a failure).
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10. Common Error Messages
This section is design to guide you through resolving application errors.

If you have an application error not listed here or if you require any further
assistance, please call the MobileIT Help Line on 1902 224 551 (Australia only).

Common error messages and their suggested solutions are as follows:

10.1 COM Port Doesn t Exist

DeskTop.SMS will report COM port doesn't exist or
modem is not properly connected! Please check
connections and try again. when it cannot access the
TWIST GSM modem.

We suggest that you verify the connections between the TWIST GSM modem and the PC
and between the modem and electrical wall socket. Ensure that the modem is switched on.

Check which COM port you have plugged the TWIST GSM modem on and open the
DeskTop.SMS Administration window. Change the COM port number as appropriate and
click on Save and Exit.

Re-open the Administration window. If you still observe the COM port doesn't exist
message, then change the COM port number to a different value and try again.

DeskTop.SMS can successfully communicate with the TWIST GSM modem when you can
observe that it is sending AT commands to the modem in the Output commands box (lower
left-hand side of the Administration window).

10.2 GSM Number Has to Have 10 Digits Minimum!

DeskTop.SMS will report GSM number has to have 10 digits
minimum! when you are trying to add a new contact to the
Phone Book that is in the correct format but does not have the
required minimum number of digits.

We suggest that you confirm that the number you are entering is a valid one and ensure
that you have entered it correctly on the Phone Book window.

A valid GSM number must have minimum of 10 digits and have a leading plus (+) symbol
followed by a country code (e.g. +61404818783).
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10.3 Invalid Activation Key

DeskTop.SMS will report Invalid Activation key  when you have entered an
invalid registration code on the Registration form window and have clicked
on the Validate Key button.

We suggest that you ensure that you have entered your registration code exactly as was
supplied by MobileIT.

If you do not have a registration code please refer to section 2.6 and contact MobileIT for
assistance.

Please note that since the registration code is directly linked to the IMEI number of the GSM
device, your registration code will be invalid if you have changed the device from the one to
which the original registration code was issued. Please contact MobileIT for a replacement.

10.4 Invalid Date/Time

DeskTop.SMS will report Invalid Date/Time when you are trying to send a
scheduled text message and have activated the date/time field on the
New Message tab but have not entered a correct date and time.

We suggest that you ensure the date and time you have entered is valid.

You must enter valid digits in the date/time field (in DD-MM-YYYY hh:mm:ss format). For
example, if today's date and time is the 26th April 2002 9:45am   (26-04-2002 09:45:00)
and you wish to schedule a text message to be sent this afternoon at 2pm, you must enter
26-04-2002 14:00:00.

Also, ensure that you have entered a date and time that is not in the present or in the past.
Scheduled SMS text messages must be set for a future date and time.
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10.5 Modem is Disconnected

DeskTop.SMS will report Modem is disconnected! Check
modem cable and connection settings. when it cannot access
the TWIST GSM modem.

We suggest that you verify the connections between the TWIST GSM modem and the PC
and between the modem and electrical wall socket. Ensure that the modem is switched on.

Check which COM port you have plugged the TWIST GSM modem on and open the
DeskTop.SMS Administration window. Change the COM port number as appropriate and
click on Save and Exit.

Re-open the Administration window. If you still observe the COM port doesn't exist
message, then change the COM port number to a different value and try again.

DeskTop.SMS can successfully communicate with the TWIST GSM modem when you can
observe that it is sending AT commands to the modem in the Output commands box (lower
left-hand side of the Administration window).

10.6 Not a Valid GSM Number!

DeskTop.SMS will report Not a valid GSM number! when you have
entered a mobile phone number into a GSM No. field that is not a valid
number.

We suggest that you confirm that the number you are entering is valid and ensure that you
have entered it correctly.

A valid GSM number must have minimum of 10 digits and have a leading plus (+) symbol
followed by a country code (e.g. +61404818783).

10.7 Nothing to Delete

DeskTop.SMS will report Nothing to delete! when you are trying to delete
a record from a table (e.g. the Messages Received table) and none exist.

We suggest that you make sure you have a record in the table before trying to delete any.
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10.8 Nothing to Export

DeskTop.SMS will report Phone Book is empty. Nothing to Export! when you
have tried to export contacts from an empty Phone Book.

We suggest that you add a few new contact entries to the Phone Book before trying to
export any.

10.9 Phone Number Must be Unique

DeskTop.SMS will report Phone Number must be unique! when you
have tried to save a new contact with a mobile phone number that is
identical to an existing Phone Book entry (even though it may have a
different name).

We suggest that you either give the contact a different number or cancel adding the contact
to the Phone Book altogether.

All contacts stored in the Phone Book must have unique GSM numbers.

10.10 Please Put Phone No. in International

DeskTop.SMS will report Please put Phone No. in
international format! when you have entered a GSM mobile
phone number that is not in the standard international
format.

We suggest that you confirm the number you are entering is valid and ensure you have
entered it correctly.

A valid GSM number must have minimum of 10 digits and have a leading plus (+) symbol
followed by a country code (e.g. +61404818783).

It is most likely that you are trying to enter a number that does not include the country
code (e.g. 0404818783). You must omit the leading 0 digit and add the code for the country
in which the GSM mobile phone is registered.

Please refer to section 12.1 for international dialling code numbers.

10.11 Range: 0 to 60

DeskTop.SMS will report Range:0 to 60 when you have tried to change the
Refresh time to a value that is outside this range (e.g. 120).

We suggest that you change the refresh time to a value between 0 and 60. DeskTop.SMS
sets the Refresh time to 30 by default.
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10.12 SMS Message(s) NOT Sent

DeskTop.SMS will report SMS message(s) NOT sent. Check
modem settings! when you have tried to send a text message
but DeskTop.SMS cannot do so.

We suggest that you check your modem setup in the Administration window and ensure
that the SMSC No. is correct and that you have entered the right Country Code.

Also, check that you have entered a valid GSM mobile phone number.

A valid GSM number must have minimum of 10 digits and have a leading plus (+) symbol
followed by a country code (e.g. +61404818783).

Try sending a test SMS text message and observe at what point in the AT command
sequence that an ERROR appears.

10.13 Type GSM Number

DeskTop.SMS will report Type GSM Number! when you have tried to send a
text message but have not entered any digits in the GSM No. field.

We suggest that you enter a valid GSM mobile phone number and try sending the text
message again.

A valid GSM number must have minimum of 10 digits and have a leading plus (+) symbol
followed by a country code (e.g. +61404818783).

10.14 Type Your Message

DeskTop.SMS will report Type your message when you have tried to send a
text message but have not entered any text in the Composure box.

We suggest that you enter some text and try sending the text message again.

Please note that SMS text messages allow a maximum of 160 characters per message and
do not allow "Enter"/carriage-returns.
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11. Un-Installing DeskTop.SMS
To un-install and completely remove your copy of DeskTop.SMS from your PC, follow this
procedure:

 You can un-install your copy of DeskTop.SMS by clicking on
the Remove DeskTop.SMS icon found in the Programs
group on the Start menu.

 DeskTop.SMS will ask you to authorise your action by presenting the Confirm File
Deletion window. Click on Yes to continue un-installing DeskTop.SMS or click on No
to exit.

 The un-installation program will now remove all
DeskTop.SMS program files that were created
during the initial installation process (including
icons).

Please note that files created post-installation (e.g. your Phone Book and message
databases) will remain on your PC after un-installation.

 When the program has removed the DeskTop.SMS files, it
will report Uninstall successfully completed!. Click on OK
to finish.
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12. Appendices

12.1 International Dialling Codes

Country IDC Country IDC Country IDC
Algeria 213 Greenland 299 Oman 968
Andorra 376 Grenada 1809 Pakistan 92
Angola 244 Guadeloupe 590 Panama 507
Anguilla 1264 Guam 671 Papua New Guinea 675
Antigua and Barbuda 1268 Guatemala 502 Paraguay 595
Antilles (Netherlands) 599 Guinea 224 Peru 51
Argentina 54 Guyana 592 Philippines 63
Aruba 297 Haiti 509 Poland 48
Ascension Island 247 Honduras 504 Portugal 351
Australia 61 Hong Kong 852 Puerto Rico 1787
Austria 43 Hungary 36 Qatar 974
Azores 351 Ibiza 34 Reunion 262
Bahamas 1242 Iceland 354 Rodriguez Islands 230
Bahrain 973 India 91 Romania 40
Bangladesh 880 Indonesia 62 Rwanda 250
Barbados 1246 Iran 98 St. Christopher 1809
Belgium 32 Iraq 964 St. Lucia 1758
Belize 501 Irish Republic 353 St. Pierre & Miquelon 508
Bermuda 1441 Israel 972 St. Vincent 1809
Bolivia 591 Italy 39 Samoa (US) 684
Bosnia-Herzegovina 387 Jamaica 1876 Samoa (Western) 685
Botswana 267 Japan 81 San Marino 378
Brazil 55 Jordan 962 Saudi Arabia 966
Brunei 673 Kenya 254 Senegal 221
Bulgaria 359 Kiribati 686 Serbia 381
Burundi 257 Korea, Republic of (South) 82 Seychelles 248
Cambodia 855 Kuwait 965 Sierra Leone 232
Cameroon 237 Lesotho 266 Singapore 65
Canada 1 Libya 218 Solomon Islands 677
Canary Islands 34 Liechtenstein 4175 Somalia 252
Cayman Islands 1345 Luxembourg 352 South Africa 27
Chile 56 Macau 853 Spain 34
China 86 Macedonia 389 Sri Lanka 94
CIS 7 Madagascar 261 Sudan 249
Colombia 57 Madeira 35191 Surinam 597
Congo 242 Majorca 34 Swaziland 268
Congo, Democratic Republic 243 Malawi 265 Sweden 46
Cook Islands 682 Malaysia 60 Switzerland 41
Costa Rica 506 Maldives 980 Syria 963
Cote d'Ivoire 225 Mali 223 Taiwan 886
Croatia 385 Malta 356 Tanzania 255
Cuba 53 Mariana Island 670 Thailand 66
Cyprus 357 Martinique 596 Togo 228
Czech Republic 42 Mauritania 222 Tonga 676
Denmark 45 Mauritius 230 Trinidad & Tobago 1868
Djibouti 253 Mexico 52 Tunisia 216
Dominica 1809 Micronesia 691 Turkey 90
Dominican Republic 1809 Minorca 34 Turks & Caicos Islands 1649
Ecuador 593 Monaco 377 Uganda 256
Egypt 20 Montserrat 1664 Union of Myanmar 95
El Salvador 503 Morocco 212 United Arab Emirates 971
Ethiopia 251 Namibia 264 United Kingdom 44
Falkland Islands 500 Nauru 674 Uruguay 598
Faroe Islands 298 Nepal 977 USA 1
Fiji 679 Netherlands 31 Vanuatu 678
Finland 358 Nevis 1869 Vatican City 39
France 33 New Caledonia 687 Venezuela 58
French Guiana 594 New Zealand 64 Vietnam 84
French Polynesia 689 Nicaragua 505 Virgin Isles (UK) 1809
Gabon 241 Niger 227 Virgin Isles (US) 1340
Gambia 220 Nigeria 234 Yemen Arab Republic 967
Germany 49 Nive Island 683 Zambia 260
Gibraltar 350 Norfolk Island 672 Zimbabwe 263
Greece 30 Norway 47

Important. When using International Dialling Codes you must remove the
leading 0 digit from your GSM mobile phone number and add a plus (+) symbol
followed by the country code (e.g. to convert the Australian mobile phone number
0404818783, remove the leading 0 and add +61 to leave +61404818783).
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12.2 Backing Up Important DeskTop.SMS Files

Primarily, we suggest that you export your message and contact databases as Microsoft

Excel .XLS files. If you perform this task on a regular basis, you will keep an accurate and
complete backup record of your message correspondence and contact details.

Please refer to sections 5.1, 5.2 and 6.5 for information on exporting your messages and
contact details.

If you wish to make a thorough backup of your copy of the DeskTop.SMS application, we
suggest that you make a dated copy of the program folder.

To backup the program folder, follow this procedure:

 Using a suitable file-managing program (e.g. Microsoft Windows
Explorer) locate the DeskTop.SMS program folder (e.g. C:\Program
Files\DeskTop_SMS by default).

 Inside the DeskTop.SMS program folder, you will find all of the files used to run the
program and to store your messages and contact details.

 Make a copy of the folder and rename it to include the date
when you made the backup.

 Move the copied backup folder to a secure location (e.g. a separate hard disk drive
or CD-ROM).

 In the unlikely event that you lose your DeskTop.SMS program folder (e.g. during a
system failure), you will be able to restore your copy from the backup.

To restore DeskTop.SMS from a backup program folder copy, follow this procedure:

 To be able to restore a previous copy of DeskTop.SMS from scratch, you must first
install from the DeskTop.SMS CD-ROM.

 Once the installation is complete, locate your
backup program folder and overwrite the
folder generated by the installation program
(e.g. C:\Program Files\DeskTop_SMS by
default).

 This action will restore your application settings, your message databases and your
contact details.

Important. You must install DeskTop.SMS from the CD-ROM before you copy
your backup folder. DeskTop.SMS will not operate correctly with out being
installed by the installation program.
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13. Contacting MobileIT
To contact MobileIT regarding a DeskTop.SMS technical issue, please call the Help Line on
(02) 8878 3236.

If you have a general or sales enquiry, you may contact MobileIT at this address:

Address: MobileIT Solutions Data Pty Ltd
Level 2, 55 Blaxland Rd,
Ryde.
New South Wales 2112
Australia

Phone:  +61 (0)2 8878 3223
Fax:  +61 (0)2 9809 0555

Web:  www.mobileit.com.au
E-Mail:  info@mobileit.com.au
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